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1 General 

1.1 Bartels AutoEngineer Product Line 
The following Bartels AutoEngineer software configurations are available: 

• Bartels AutoEngineer Schematics  

• Bartels AutoEngineer Light  

• Bartels AutoEngineer Economy  

• Bartels AutoEngineer Professional  

• Bartels AutoEngineer HighEnd  

• Bartels AutoEngineer IC Design  

• Bartels AutoEngineer FabView  

Bartels AutoEngineer Professional is the standard BAE software configuration. BAE Professional is available 
for PCs with Windows, Linux, or DOS operating systems. BAE Schematics, the schematic editor of BAE 
Professional is freely available and can be operated in stand-alone mode. Demo software configurations of 
BAE Professional (fully-featured except for data output) are available free of charge for test and evaluation 
purposes. 

Bartels AutoEngineer Light is a shareware price-level BAE configuration for educational purposes and/or 
semi-professional users, available for PCs with Windows, Linux or DOS operating systems. BAE Light has 
full BAE Professional functionality, however, limited to a maximum PCB layout size of 180mm * 120mm and 
a maximum of two signal layers for manual routing and Autorouter. 

BAE Economy is a low-price BAE configuration for educational purposes and/or small business users, 
available for PCs with Windows, Linux or DOS operating systems. BAE Economy has full BAE Professional 
functionality, however, limited to a maximum PCB layout size of 350mm * 200mm and a maximum of four 
signal layers to be simultaneously routed by the Autorouter. 

Bartels AutoEngineer HighEnd is available for workstations and for PC systems (Windows 
95/98/ME/NT/2000/XP, Linux). BAE HighEnd utilizes special operating system characteristics (multi-tasking, 
multi-windowing, virtual memory management, etc.) to implement advanced features and functions such as 
HighSpeed kernel, in-built messaging system to support advanced communication between different BAE 
modules, in-built multi-tasking to support multiple project views, global net highlight, cross-probing, selective 
layout short-circuit display, extremely fast Mincon airline calculation, optimized data structures for high 
Autorouter performance, advanced Neural Rule System features, rule-driven Neural Autorouter, nettype-
specific routing area definitions, net-specific maximum via count settings, net-specific maximum connection 
length settings, etc. 

BAE HighEnd is optionally available with Bartels AutoEngineer IC Design (BAEICD). BAE IC Design is a 
complete CAD/CAM system for the physical design of integrated circuits (gate arrays, standard cells, custom 
ICs and/or ASICs). BAEICD consists of a series of system components such as IC Mask Editor, IC 
Autoplacement, IC Autorouter, IC DRC (Design Rule Check) and GDS-II and CIF standard interfaces. 

Bartels AutoEngineer FabView is a low-cost PCB layout viewer with manufacturing data output functions. 
BAE FabView is intended for PCB manufacturing departments and service providers who only have to 
produce manufacturing data and print/plot outputs but don't have to edit layouts. BAE FabView can be used 
together with BAE Professional and/or BAE HighEnd. BAE FabView provides the same functionality, 
however, the functions for saving design changes to BAE project files are deactivated. 
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1.2 System Requirements 

General System Requirements 

A VGA or higher resolution monitor with a screen resolution of at least 800*600 pixels and a mouse or a 
corresponding pointing device are required on any BAE platform. 

Up to 40 Mbytes hard disk space are required for installing the BAE software. 

Operating System 

BAE Light, BAE Economy and BAE Professional versions are available for Linux (Kernel 2.0.x and above), 
Windows XP, Windows 2000, Windows NT 4.0, Windows NT 3.51, Windows ME (Millenium Edition), 
Windows 98, Windows 95 and MS-DOS. 

BAE HighEnd and BAE IC Design systems are available for Hewlett-Packard 9000/7xx workstations with 
OSF/Motif and/or X11 and for PCs with Linux (Kernel 2.0.x and above), Windows XP, Windows 2000, 
Windows NT 4.0, Windows NT 3.51, Windows ME (Millenium Edition), Windows 98, and Windows 95 
operating systems. 

BAE Schematics and BAE FabView systems are available for all of the afore-mentioned platforms. 

PC System Requirements 

PC systems should be equipped with a Pentium (80586, 80686) or at least a 80486DX processor. Any 
compatible processor such as AMD-K6 or AMD-K7 (Athlon) will also do. 

A minimum of 8 Mbytes RAM is required for DOS systems (16 Mbytes RAM recommended). A minimum of 
32 Mbytes RAM is required for Windows 95/98/ME/NT/2000/XP and Linux systems (64 Mbytes RAM or more 
recommended). 

The BAE software is usually provided on CD-ROM, i.e., a CD-ROM drive is required to install the software. 

A hardlock key is used to protect BAE Economy, BAE Professional and BAE Fabview Windows and DOS 
versions against software piracy. I.e., a printer port (LPT1, LPT2, or LPT3) is required to run these BAE 
versions under DOS and/or Windows. 

On Linux systems, either a printer port (for the hardlock key) or an Ethernet card is required for checking the 
software authorization of BAE Economy, BAE Professional, BAE HighEnd and BAE FabView. 

1.3 Documentation 
Both the Bartels AutoEngineer User Manual and the Bartels User Language Programmer's Guide have 
been completely revised and are provided in HTML and PDF format (in the baedoc directory of the BAE CD-
ROM). 
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1.4 Installing on Windows and DOS Platforms 

Preparing for Update Installations 

The BAE library and User Language directory contents are replaced when performing update installations. 
Thus it is strongly recommended to backup any user-specific data from these directories before installing the 
BAE update, and to restore the required data afterwards. 

The bsetup.dat file from the BAE programs directory is always re-installed when performing BAE Update 
Installations. Thus it is not necessary to run the time-consuming batch for compiling the BAE User Language 
programs provided with the BAE software. However, user-specific BAE parameter settings stored with the 
existing bsetup.dat file will get lost and must be restored after successfully installing the BAE software using 
the bsetup utility program (or the Setup function available from the BAE main menu of the Windows/Motif 
versions). Customer-specific User Language programs developed and compiled under the previously 
installed BAE version must also be re-compiled after performing the BAE Update Installation. 

The bae.ini file with user-specific parameter settings, key assignments and menu definitions is not 
overwritten when performing update installations. The bae54.ini file is provided for documentation purposes. 
bae54.ini contains all new parameter definitions and can be appended to bae.ini if required. 

Running the Windows 95/98/ME/NT/2000/XP Install Program 

Under Windows 95/98/ME/NT/2000/XP, the BAE setup program for installing BAE Demo, BAE Schematics 
BAE Light, BAE Economy, BAE Professional, BAE HighEnd, BAE IC Design and/or BAE FabView should 
start automatically after inserting the BAE CD-ROM to the CD-ROM drive. If this doesn't happen, simply start 
the setupen.exe program from the CD-ROM using the Run function from the Windows Start menu. Please 
follow the instructions of the setup program. 

The setup ends with the BAE software configuration. Please select the BAE configuration which is authorised 
for your machine (BAE Demo, BAE Schematics, BAE Light, BAE Economy, BAE Professional, BAE 
HighEnd, BAE IC Design oder BAE FabView; see also table 1). 

Running the MS-DOS Install Program 

For installing BAE Schematics, BAE Economy, BAE Professional, BAE HighEnd or BAE FabView under MS-
DOS, the CD-ROM must be inserted to the CD-ROM drive, and the drive and directory must be set 
accordingly. E.g., to install the BAE software from CD-ROM drive D, insert the BAE CD-ROM to CD-ROM 
drive D, and enter the following commands to the DOS prompt: 

> D: <CR> 
> install <CR> 

Once the install program has been started, the instructions issued on the screen should be followed 
carefully. First you will be asked for the BAE user interface language (e.g., English, German, etc.) and for the 
operating system host platform (DOS, Windows NT, etc.). 

The install program provides different modes for performing either new Installation or Update installations. 
The Update install mode is strongly recommended when just updating from earlier BAE Versions; this will 
prevent the install program from overwriting special BAE system and setup files ending on .dat, .def, and .fnt 
(otherwise, user-defined color tables, aperture tables, fonts, layer definitions, library access path settings, 
and menu setups stored with these files might get lost!). 

After selecting the install mode, you will be prompted to specify the destination directories for installing the 
programs, the libraries, the User Language source files, and the examples and test jobs. You can exclude 
certain destination directories by deleting the corresponding path names. Thus more experienced BAE users 
can e.g., suppress the installation of the BAE example jobs, or re-install certain parts of the BAE software 
later. For security reasons, the install parameter settings will be verified with user query before starting the 
installation process. The destination directories will be created automatically on request. The install program 
automatically copies the BAE software files to the selected destination directories on the hard disk. 
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At the end of the install process, the install program asks for the licensed BAE software configuration in order 
to install the correct software authorization file (see below). When installing the DOS version, the user will 
also be asked to select the graphic device driver to be installed (see below). 

Installing the Software Security Module 

The BAE PC software for Windows and DOS (except for BAE Demo, BAE Light and BAE Schematics) is 
protected by a hardlock key (dangle) which must be plugged onto one of the parallel ports (LPT1, LPT2, or 
LPT3) of your PC. Switch off your computer before mounting the hardlock key shipped with the software, or 
otherwise the dangle might be damaged by high voltage! If you have connected a peripheral device such as 
a laser printer to the hardlock key, then you must always switch on the peripheral device before switching on 
your computer to avoid hardlock key check problems. 

The BAE PC software provides the license files according to the available software configurations as shown 
in the table below. You will be asked to select the BAE software configuration (and thus the appropriate 
license file) when installing the BAE software. Make sure to select the BAE software configuration to be 
installed and/or authorized on your computer. 

Table 1: BAE Software License Files 

 Software 
Configuration 

License File 
Name Note 

BAE Demo demo.cfg SCM and Layout; no Hardlock Key, no (CAM) output 

BAE Schematics schema.cfg SCM only; no HardlockKey 

BAE Light see note SCM and Layout; no Hardlock Key, customer-specific CFG file is provided on purchase 

BAE Economy economy.cfg SCM and Layout 

BAE Professional autoeng.cfg SCM and Layout 

BAE HighEnd highend.cfg SCM and Layout 

BAE Layout layout.cfg Layout only; required/provided only for updating from BAE Versions older than BAE V4.6 

BAE IC Design icdesign.cfg SCM, Layout and IC Design 

BAE FabView fabview.cfg CAM/manufacturing data output; save to DDB file deactivated 

The router.cfg license file matching the BAE software configuration authorized on your computer must be 
available in the BAE programs directory. I.e., to install the correct license file you can also copy the desired 
CFG file to router.cfg within the BAE programs directory instead of selecting the valid BAE configuration 
during BAE software installation 

BAE Demo software is intended for evaluation purposes only. BAE Demo cannot produce any CAM or User 
Language output, and it will mask Layout board elements in order to prevent from processing with productive 
software configurations afterwards. I.e., the BAE user version are not able to read Demo jobs, however, we 
are able to convert these jobs. 
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Selecting the BAE DOS Graphic Device Driver 

With the Windows versions of the BAE software there is no BAE graphic device driver installation required 
since BAE Windows software runs under the graphic interface of the corresponding operating system. 

The DOS versions of the BAE software are shipped with a series of graphic device drivers. During 
installation you will be asked to select an appropriate BAE graphic device driver. Table 2 provides the list of 
graphic device drivers supplied with the DOS PC software of the Bartels AutoEngineer. Please select the 
graphic device driver matching the video adapter and/or graphic card installed with your computer. It is 
recommended to install the standard VGA driver VGA480, if you are not sure about which driver to select 
since VGA480 is assumed to run on almost any PC system, and you can always select a different driver 
(e.g., with higher resolution) later (see below). 

Table 2: BAE Graphic Device Drivers 

 Graphic Driver Type Resolution Chip Set/Manufacturer 

CCD480.DEV  PGA 640x 480 IGC (Cad Card) 

EGA350.DEV  EGA 640x 350 Standard 

EGA480EW.DEV EEGA 640x 480 EGA Wonder 

EGA480GE.DEV EEGA 640x 480 Genoa, ATI 

EGA600EW.DEV EEGA 800x 600 EGA Wonder 

EGA600GE.DEV EEGA 800x 600 Genoa, ATI 

EGA600PA.DEV EEGA 800x 600 Paradise 

QPC1024.DEV  - 1280x1024 Datapath QPDM 

QPDM768.DEV  VGA 1024x 768 AMD QPDM 

QPDM1024.DEV VGA 1280x1024 AMD QPDM 

VGA480.DEV  VGA 640x 480 Tseng ET3000 / ET4000 

VGA600.DEV  VGA 800x 600 Tseng ET3000 / ET4000 

VGA768.DEV  VGA 1024x 768 Tseng ET3000 

TSENG768.DEV VGA 1024x 768 Tseng ET4000 

VESA600.DEV  VESA 800x 600 various 

VESA768.DEV  VESA 1024x 768 various 

MACH768.DEV  - 1024x 768 ATI Mach 64 

MACH1024.DEV - 1280x1024 ATI Mach 64 

MACH1200.DEV - 1600x1200 ATI Mach 64 

MGA600.DEV  - 800x 600 Matrox Millenium/Mystique 

MGA768.DEV  - 1024x 768 Matrox Millenium/Mystique 

MGA1024.DEV  - 1280x1024 Matrox Millenium/Mystique 

MGA1200.DEV  - 1600x1200 Matrox Millenium/Mystique 

TIGA.DEV  TI variable Texas TMS34010 / TMS34020 
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The graphic driver .dev file matching the video adapter and/or graphic card of your computer must be copied 
to the bae.dev file in the BAE programs directory. This is achieved either by selecting the correct driver 
during BAE software installation or by manually copying the desired .dev file in the BAE programs directory 
to bae.dev. 

Setting up the DOS Environment 

It is strongly recommended to add the BAE programs directory path to the PATH environment variable. Load 
the autoexec.bat file to your text editor and check whether autoexec.bat contains a PATH statement or not. If 
there is already a PATH statement defined in autoexec.bat, then just add the following program path link to 
the PATH statement (assume BAE programs directory c:\bae): 

;c:\bae 

If there is no PATH statement defined in autoexec.bat, then insert the following PATH statement (assume 
BAE programs directory c:\bae): 

PATH=c:\bae 

You can also insert the following command at the end of the autoexec.bat file in order to include the BAE 
programs directory path name with the PATH variable: 

PATH c:\bae;%path% 

The config.sys file must contain the statements 

BUFFERS=<b> 
FILES=<f> 

where the number <b> of buffers should be at least 30, and the number <f> of files should be at least 20. 

Note that you must reboot your computer if you made any changes to the config.sys or autoexec.bat. 
Otherwise you might not be able to start BAE. 

1.5 Installing on Linux and UNIX Platforms 

Preparing for Update Installations 

The BAE library and User Language directory contents are replaced when performing update installations. 
Thus it is strongly recommended to backup any user-specific data from these directories before installing the 
BAE update, and to restore the required data afterwards. The same backup and restore process should be 
applied to BAE programs directory files with extensions .dat (except for bsetup.dat; see next paragraph), 
.def, and .fnt when just updating from earlier BAE versions since these files can contain user-defined color 
tables, layer definitions, Gerber aperture tables, and character fonts which will be overwritten during update 
installations. The router.cfg file must also be saved and restored when updating from authorized BAE 
versions. 

The bsetup.dat file from the BAE programs directory will always be re-installed when performing BAE Update 
Installations. Thus it is not necessary to run the time-consuming batch for compiling the BAE User Language 
programs provided with the BAE software. However, user-specific BAE parameter settings stored with the 
existing bsetup.dat file will get lost and must be restored after successfully installing the BAE software using 
the bsetup utility program (or the Setup function available from the BAE main menu of the Windows/Motif 
versions). Customer-specific User Language programs developed and compiled under the previously 
installed BAE version must also be re-compiled after performing the BAE Update Installation. 
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Linux Installation 

The baelinux directory on the BAE CD-ROM contains the baelinux.tgz and baelinus.tgz TGZ archive files 
with different BAE builds for operating BAE Demo, BAE Light, BAE Economy and BAE Professional under 
Linux. Each of these TGZ files contains the directories bin (programs and setup files), baelib (symbol and 
part libraries), baeulc (User Language source files), and baejobs (examples and test jobs). The BAE 
software is supposed to run on all common Linux system with Kernel 2.0.x (S.u.S.E. 6.0 or later, RedHat, 
etc.). The TGZ files baelinhe.tgz and baelinhs.tgz contain the binaries for BAE HighEnd. An additional file 
named baeeng.tgz including the English BAE user interface setup is also provided. 

We strongly recommend that you have a look into the readme file from the baelinux directory of the BAE CD-
ROM before installing the BAE Linux software. The readme file contains a list of the provided BAE Linux 
archive files and latest information and important instructions for installing the BAE Linux software. 

baelinus.tgz must be installed on Linux systems without Motif. baelinus.tgz contains a statically linked BAE 
version including all system and Motif libraries (libc6/glibc, lesstif/Motif1.2) required to run BAE on any Linux 
Kernel 2.0.x distribution. 

It is recommended to use the more efficient dynamically linked BAE version from baelinux.tgz (linked to 
libc6/glibc and Motif2.0) on Linux systems where Motif is already installed. The statically linked version from 
baelinus.tgz can always be used on Linux systems which fail to run the dynamically linked version. 

To install the BAE Linux software, simply mount the CD-ROM drive with the BAE-CD-ROM (e.g., under 
/cdrom), change to the directory where you want to install the BAE software, and unpack the appropriate 
archive file (e.g., baelinux.tgz) using the tar command as in 

> tar -xzfv /cdrom/baelinux.tgz <CR> 
The -z option is used to filter the TGZ file through the gzip utility. If your tar command does not support the -z 
option, simply use gzip and tar as in 

> gzip -dv /cdrom/baelinux.tgz <CR> 
> tar -xfv /cdrom/baelinux.tar <CR> 

To install the dynamically linked BAE HighEnd version, simply extract the baelinhe.tgz file after installing 
baelinux.tgz. To install the statically linked BAE HighEnd version, simply install baelinhs.tgz after installing 
baelinus.tgz. 

A configuration file is provided with productive BAE Linux versions. This configuration file (router.cfg) must 
be saved to the BAE program directory (bin, see above). To activate BAE Demo, the demo.cfg configuration 
file must be copied to router.cfg, to activate BAE Schematics, schema.cfg must be copied to router.cfg (see 
also Table 1). 

BAE is pre-configured with a German user interface. The English user interface can be activated by 
extracting the baeeng.tgz archive file from the CD-ROM baelinux directory to the destination directory. 



Bartels AutoEngineer  Version 5.4 

Release Notes  Page 12 

UNIX Installation 

The BAE HighEnd archive files for UNIX workstation are provided in specific BAE-CD-ROM directories such 
as baehp for the HP version. These archive files contain the directories bin (programs and setup files), baelib 
(symbol and part libraries), baeulc (User Language source files), and baejobs (examples and test jobs). An 
additional file named baeeng.tgz including the English BAE user interface setup is also provided. 

The BAE HighEnd archive files for HP workstations are provided in the baehp directory on the BAE CD-
ROM. Please see the readme file in the baehp directory for latest information and instructions on how to 
install the BAE HP software. 

To install the HP software, simply mount the CD-ROM drive with the BAE-CD-ROM (e.g., under /cdrom), 
change to the directory where you intend to install the BAE software, and unpack the baehp.tgz archive 
using the tar command as in 

> tar -xzfv /cdrom/baehp.tgz <CR> 
This installs the BAE HighEnd software with OSF/Motif interface. To activate the BAE HP software for X11, 
the baehpx11.tgz file from the baehp directory on the CD-ROM must be installed in the destination directory 
after installing baehp.tgz. 

A configuration file is provided with productive BAE UNIX versions. This configuration file (router.cfg) must 
be saved to the BAE program directory (bin, see above) To activate BAE Demo, the demo.cfg configuration 
file must be copied to router.cfg, to activate BAE Schematics, schema.cfg must be copied to router.cfg (see 
also Table 1). 

BAE is pre-configured with a German user interface. The English user interface can be activated by 
extracting the baeeng.tgz archive file from the CD-ROM baelinux directory to the destination directory after 
installing the UNIX software. 

Setting up the Linux/UNIX Environment 

The access rights must be set properly (i.e., execute for the programs, read access to the libraries, 
read/write access to the job files, all rights for the system administrator, special rights for the library manager, 
etc.). The user must have read access to the BAE program directory files ending on .cfg (for authorization 
check) and read/write access to the files with extensions .dat and .fnt. The user must also have write access 
in the working directory to enable temporary file creation. 

The Linux/UNIX shell environment variable PATH must point to the BAE programs directory to allow for BAE 
program call from any other directory. The PATH variable can be set automatically through shell profile 
execution (shell script .profile, .login, .bashrc, or .cshrc, according to UNIX derivative, respectively). 
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1.6 Parameter Setup and Program Start 

BAE System Parameter 

The BAE software versions for Windows and Motif provide an interactive program for modifying the BAE 
system parameters. Under DOS, however, the bsetup utility must be applied as described herein. 

With the BAE software, a setup definitions file template named stdset.def is supplied, which will be installed 
to the BAE programs directory. This file contains the following commands for setting the BAE library access 
paths: 

SCMDEFLIBRARY("<libdir>\stdsym"); 
LAYDEFLIBRARY("<libdir>\laylib"); 

where <libdir> is the path name of the BAE library directory. If the library e.g., has been installed to the 
directory c:\baelib under DOS or Windows then you should replace <libdir> with this path name in order to 
provide correct access to the BAE symbol libraries. If the library e.g., has been installed to the directory 
/usr/bae/lib under Linux or Unix, then you should insert the following commands to the setup definitions file 
for providing correct access to the supplied BAE symbol libraries: 

SCMDEFLIBRARY(/usr/bae/lib/stdsym); 
LAYDEFLIBRARY(/usr/bae/lib/laylib); 

The setup definitions file can be transferred to the BAE setup file bsetup.dat using the following bsetup 
program call (assuming stdset.def to be the name of the setup definitions file, and the BAE programs 
directory to be the working directory): 

> bsetup stdset <CR> 
The bsetup utility program is also used for defining important system parameters such as the documentary 
layer definitions and the menu setup. The documentary layer definitions and assignments have major impact 
on how manufacturing data is generated. Thus it is strongly recommended to get familiar with the features of 
the bsetup utility program before using BAE for the design of real layouts. See Bartels AutoEngineer User 
Manual - Chapter 7.2 for details on how to use bsetup. 

User Language Programs, Menu Assignments, Key Bindings 

The BAE software installs many pre-compiled User Language programs to the bsetup.dat file of the BAE 
programs directory. The corresponding source files are are also provided in the User Language directory 
(baeulc). See Bartels User Language Programmer's Guide - Chapter 4 for a complete listing and short 
descriptions of the BAE User Language programs. 

Some of the installed User Language programs define implicit User Language program calls for activating a 
modified BAE user interface with many additional functions. You can add even more functions, or you can 
modify and/or reset the predefined menu assignments and key bindings. For more details see section 11.5 
of these Release Note. 

Usually, it is not necessary to (re-)compile the User Language programs delivered with the BAE software, 
since the compiled programs will be installed to the bsetup.dat file of the BAE programs directory. 
Nevertheless, the User Language directory provides several batch files for automatically compiling all BAE 
User Language programs. The CPLSLL (ComPiLe with Static Link Library) batch file is recommended for 
compilation. The compile batch can be started in the User Language directory (baeulc) by entering 

> cplsll <CR> 

to an MS-DOS-Prompt (with the PATH variable pointing to the BAE programs directory!) or with the 

> cplsll.bat <CR> 
command from a Linux or UNIX shell. The compilation process might last some time according to the power 
of your computer. 



Bartels AutoEngineer  Version 5.4 

Release Notes  Page 14 

BAE Program Start and DDB File Access 

Use the following command to start the Bartels AutoEngineer from a DOS prompt or a Linux and/or UNIX 
command shell: 

> bae <CR> 
Design file access can be simplified by starting and/or running BAE from the design and/or project files 
directory. 

Under Windows, the Bartels AutoEngineer can also be started by selecting the bae.exe file using the Run 
function from the Windows Start menu. Windows also allows for application startup by double-clicking the 
application from within the Windows Explorer, and it is also possible to define an initial working directory for 
the application to start in. A shortcut to bae.exe can be placed on the desktop or the Windows Start menu to 
provide an even more convenient method of starting up the Bartels AutoEngineer. 

When installing the BAE software under Windows 95/98/ME/NT/2000/XP, a BAE program group with 
shortcuts for starting the BAE main menu (BAE Main Menu) and the BAE program modules (BAE Setup, 
Schematic Editor, Packager, Layout Editor, Autorouter, CAM Processor, CAM View) and for accessing the 
Bartels AutoEngineer User Manual (BAE User Manual) is added to the Windows start menu. 

The BAE DDB File option for creating a new BAE DDB file named New BAE DDB File is included with the 
New function from the Windows 95/98/ME/NT/2000/XP Desktop and Windows Explorer context menus to be 
activated through the right mouse button. The BAE DDB file context menus provide the BAE Schematic and 
BAE Layout options for loading the selected BAE file to the Schematic Editor and/or the Layout Editor. 
Double-clicking a BAE DDB file automatically loads the DDB file's standard layout element to the Layout 
Editor. The system suggests to create a new layout element if the DDB file does not yet contain a layout 
element with default name. 

Please consult your operating system documentation for more information on how to configure applications 
for startup. 

File Access Environment Variables 

Environment variable references in file name specifications are automatically substituted. This allows for 
definitions such as $BAELIB for the symbol library directory and combined specifications such as 
$BAELIB/laylib or $BAELIB/$STDLIB to be used for path and file name specifications in functions such as 
Select Library from the Settings/Parameter menu. The environment variables are not evaluated until they are 
actually referred for file access. Thus they will be stored with design files to be transferred to different 
computers where they can refer to machine-dependent path specifications defined through corresponding 
environment variables. Environment variable references are preceded with a dollar sign ($) and must be 
either entirely lower-case or entirely upper-case. The ~ character refers to the $HOME variable. Undefined 
environment variable references are substituted with empty strings. 
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System File Access Environment Variables 

The environment variables listed in table 3 are evaluated for advanced configuration of BAE system file 
access in network installations. 

Table 3: BAE System File Environment Variables 

 Environment Variable System FileDefault Name Contents 

BAE_CFG  router.cfg BAE Configuration/License File 

BAE_BSETUP  bsetup.dat BAE System Parameters 

BAE_ULCLIB  bsetup.dat BAE User Language Programs 

BAE_RULELIB brules.dat BAE Rules Database 

BAE_LANG  language.dat BAE Menu String Tables (language-specific) 

BAE_FONTLIB ged.fnt BAE Graphic Character Fonts 

BAE_SCMLIB  scm.dat SCM Color Tables 

BAE_GEDLIB  ged.dat PCB Layout Color Tables 

BAE_CEDLIB  ced.dat IC Layout Color Tables 

BAE_CAMLIB  cam.dat CAM Gerber Aperture Tables 

BAE_DCOLLIB bae.col BAE Display Color Table 

BAE_PCOLLIB baep.col BAE Printer Color Table 

BAE_WINLIB  baewin.dat 
baexwin.dat 

BAE Windows Position File 

BAE_CLIPB  baeclipb.dat BAE Clipboard File 

Environment variables must specify complete paths to the corresponding system files. This feature can be 
used in definitions such as 

set BAE_WINLIB=d:\bae\user1.dat 

where access to a machine-specific Windows positions file in network installations with central BAE 
programs directory is established. 

System files without environment variable definition are accessed from the BAE programs directory using the 
default system file name. The BAE_PROGDIR environment variable allows for the specification of an 
alternative system file directory. 

Windows System Font Selection 

The ANSI_FIXED_FONT system font is used on default for displaying status line and dialog text in BAE 
Windows versions. Alternatively, SYSTEM_FIXED_FONT can be selected by assigning an arbitrary value to 
the BAE_OLDFONT environment variable if ANSI_FIXED_FONT isn't suited for the configured 
screen/monitor resolution. 
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1.7 User Interface and General Functions 

Text Input 

Most status/message line input prompts have been replaced by comfortable text input dialogs with cursor 
key support and operating system specific cut, copy and paste functions. 

DBB File Access Rights under Unix and Linux 

The access rights for new DDB files under Unix and Linux will now be set according to the current umask 
settings. Previously, only read and write access rights were granted to the file owner. 

1.8 Symbol and Part Libraries 
The SCM symbol and layout part libraries have been completely revised. A series of new symbol and part 
definitions have been added to the SCM and layout libraries. 

SCM symbol name and attribute texts have been centered to standardize the visual appearance of symbols 
with different symbol name lengths and attribute values. 

The new Center Coords. documentary layer 10 has been introduced for layout part definitions. This layer is 
reserved for insertion pick point texts on part center points coordinates. Insertion pick point texts have been 
added to the Center Coords. documentary layers of the part definitions from the laylib.ddb and smd.ddb 
layout libraries. 

PDF files displaying all graphic symbols of the officially released BAE libraries are provided in the pdflib 
directory of the BAE-CD-ROM. 

A series of useful library management User Language programs for library management (library check, 
automatic symbol edit, automatic generation of library documentation, etc.) are installed with the BAE 
software. See Bartels User Language Programmer's Guide - Chapter 4 for a complete listing of the User 
Language programs provided with the BAE software. 
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2 Schematic Editor 

2.1 General 

Size Specifications 

Input value dialogs have been added for size specifications such as text heights to allow for the editing of 
existing values. 

User Language Programs 

A series of new SCM functions and features such as 

• Advanced dialog for symbol attribute value assignments (ATTRSET)  

• text class assignments for display and plot text visibility control (SCMTEXT)  

• symbol edit batch functions for automatic standard and/or commentary text placement to symbol 
origin (SYMEDBAT)  

have been implemented with User Language programs. 

2.2 Symbols, Labels 

Symbol Macro Selection 

The symbol macro name query of the Add Symbol function has been replaced by a dialog with a symbol 
macro name input field and listboxes for optional project file symbol macro selection, library file symbol 
macro selection and library directory file selection. Additionally, the Other Library button is provided for 
selecting symbol macros from any other DDB file. 

Attribute Assignments 

The attribute assignment dialog of the Assign Value(s) function has been re-implemented with advanced 
features through the ATTRSET User Language program. 

A Browse button for selecting existing part macros and/or logical part definitions from the default layout 
library is displayed for the $plname and $rlname attributes. 

A Default button is provided for assigning default attribute values as defined on symbol level. 

The bae.ini configuration file allows for the definition of attribute descriptions (e.g., (Part Package) for the 
$plname attribute) to be displayed in the attribute input dialogs. 

Name and Attribute Text Positions 

The Keep Text Positions option has been added to the Settings function from the Settings menu. The Keep 
Text Positions default mode off causes the Move Symbol/Label function to reset any symbol name and 
attribute text positions, whilst the on mode preserves non-default symbol name and attribute text position 
settings. 
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Net Attribute Assignments through Label Symbols 

The Symbol Tagmode function has been changed to allow for the assignment of tag modes to label macros. 
The Standard Label option processes labels in the usual/default way. The new Net Attr. Label option 
transfers a synthetically generated label tag symbol into the scmematic net list. The tag symbol name refers 
to the logical libarary definition of the label macro (name). The corresponding logical library definition is 
supposed to be virtual and can provide any number of newattr commands for defining net attributes which 
will be assigned to the label net by the Packager. This feature is useful for assigning net attributes such as 
net types and/or DRC blocks to a series of nets without having to place numerous attribute symbols. The 
new Set Label Macros function (see below) can be applied to prepare older SCM plans for this new feature. 

2.3 Connections 

Signal Routing 

The functions for automatically re-routing connections when moving symbols and/or groups have been 
improved. 

A new option for activating and/or deactivating signal routing for symbols and/or gorups has been added to 
the Settings dialog from the Settings menu. 

2.4 Text, Attributes 

Text Visibility Control Text Classes 

The Text Class function with the Text Assignment, Symbol Mask and Sheet Mask options has been added to 
the Other Functions submenu from the Text menu. Text Class can be used to assign text classes for display 
and/or plot visibility control. The Text Assignment option activates a dialog box for assigning text classes to 
mouse selectable texts. The Symbol Mask option can be used on schematic plan level to fade-out texts of a 
specific text class from mouse-selectable symbols. The Sheet Mask option can be used to fade-out all 
schematic plan level texts of a specific text class. Each text can be assigned to different text classes. A text 
is faded-out if one its assigned text classes is faded-out. Texts without text class assignment are always 
visible. 

A total of up to 31 different text classes are supported. Text class names can be optionally specified in the 
bae.ini file. The system assignes default text class names such as Class 1, Class 2 etc. if no text class 
names are defined in bae.ini. 

Text classes can be used to increase the legibility of schematic plans by fading out less significant (symbol) 
attributes. 

The Combine Rotations function from the Rule Attachment submenu of the Settings menu assigns class 31 
to texts which are defined for nonzero symbol rotation angles. This causes Sheet Mask to fade-out rotation 
texts whilst editing combined symbols. 

Special Texts for Element Data Display 

The $pltfname (element file path name), $pltfsname (element file name) and $pltpname (element plan name) 
texts can be placed to display the project file path name, the project file name (without directory path) and 
the element name of the currently loaded top level element. 

The $pltstime (element save time), $pltsdatede (element save date, German notation) and $pltsdateus 
(element save date, US English notation) texts can be placed to display the time and date the currently 
loaded top level element was last saved. 
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2.5 Group Functions 

Clipboard 

The Cut, Copy and Paste functions for saving and/or loading group elements to and/or from the clipboard 
have been added to the Edit menu. The data is saved in the BAE programs directory to a temporary file 
named hostnameclipb.dat (hostname is the network name of the host computer). 

Multiple Group Definitions 

The Set Group Name function for assigning a group name to the currently selected group elements has been 
added to the Other Functions submenu of the Edit menu. The Group Name has been added to the Select 
and Deselect group functions to allow for group selections through group name specifications. 

Unlike group selection status flags, group name assignments are saved with the project. I.e., group name 
assignments are permanent, allowing for grouped circuitry to be easily re-selected and/or re-processed in 
later sessions. 

Group Selection by Symbol Name 

The Name option for selecting and/or deselecting SCM groups by symbol name has been added to the 
Select and Deselect functions from the Other Functions submenu of the Edit menu. The symbol name group 
selector can specified by picking from the list of currently used symbols, or by symbol name pattern input. 

Change Label Macros 

The Set Label Macros function for changing group-selected label macros has been added to the Other 
Functions submenu of the Edit menu. Set Label Macros changes only labels without implicit label macro 
assignment through label name. 
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3 Packager 

3.1 Parameter Settings 

Parameter Memory 

The Packager settings for the layout library name, the alternative layout library name and the layout element 
are saved with the project files and will be reloaded with future Packager runs. This allows for the Packager 
and back and Packager and Layout Schematic Editor functions to be applied to projects with non-default 
layout element names. 

3.2 Error Handling 
The Error Control function for controlling the Packager behaviour in case of missing layout parts and/or pins 
has been added to the Settings menu. The Standard option causes the Packager to abort with an error 
message on missing layout parts and/or pins. The Ignore miss. Pins option causes the Packager to issue 
missing layout part/pin warning messages without aborting the packaging process. 

Warning 
The Ignore miss. Pins option should be used carefully since it can create physically non-existing layout net 
list pins for missing logical pin definitions. For this reason, the Ignore miss. Pins Error Control setting is not 
saved with the project file, i.e., it has to be re-selected in subsequent Packager runs. It is strongly 
recommended to apply a layout net list consistency check using the CHECKLNL User Language program on 
layouts created with Ignore miss. Pins Error Control option. 

3.3 Bus Net Attributes 
The Packager has been updated so that net attributes assigned to busses through virtual symbols and/or tag 
symbols are now being propagated to all nets of the affected bus. 

3.4 Layout Library 

Alternative Library 

The Alternate Library parameter for specifying a second layout library has been added to the Settings menu. 
The Packager searches the alternative library for logical part definitions and/or layout part macros which are 
neither in the project file nor in the standard layout library. 

Automatic Project Layout Library Generation 

The Packager copies referenced part macros from the standard and/or alternative layout library to the project 
file, thus enabling the generation of project specific layout libraries during packaging. 

3.5 Logical Library Definition Update 
The Update Mode parameter with the No Update and Definition Update options has been added to the 
Settings menu. No Update is the default setting for transfering only those logical part definitions from the 
library file(s) which are not yet in the project file. Definition Update forces the logical part definitions from the 
library file(s) to be copied to the project file, thus overwriting (updating) existing logical part definitions in the 
project file. Logical part definitions which only exist in the project file are not changed. 
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3.6 ERC (Electrical Rule Check) 
The Packager evaluates $pintype pin attribute settings to perform electrical rule checks (ERC). It is 
recommended to assign fixed ERC pin types through the logical symbol/part definitions. The following pin 
type attribute value settings are currently supported: 

• in (input)  

• out (output)  

• bidi (bi-directional pin)  

• anl (analog signal pin)  

• sup (power supply pin)  

The ERC issues a warning message such as Net 'netname' has only inputs! if a net with one or more input 
pins has no (normal, bi-directional or power supply) output pin. A warning message such as Driver collision 
on net 'netname'! is issued if a normal output pin is connected to another output pin, a bi-directional pin or a 
power supply pin. 
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4 Layout Editor 

4.1 General 

Size Specifications 

Input value dialogs have been added for size specifications such as trace widths and text heights to allow for 
the editing of existing values. 

Net List Import 

The ICAP Input function for importing packed net lists from Intusoft's ICAP/4 SCM/simulation tool (Version 
8.2.10 / 1843 and above; Tango net list export) has been added to the Import/Export submenu of the File 
menu. 

User Language Programs 

A series of new Layout Editor functions and features such as 

• ICAP net list import (ICAPNET, GEDIO)  

• part insertion pick point query (GEDPART)  

• part placement with automatic part selection and position suggestion (GEDPART)  

• automatic placement of hierarchical part groups (GEDPART)  

• angle measuring (GEDDRAW)  

• copper fill keepout area generation (GEDPOLY)  

• arbitrary scaling factor settings for EPS and PDF output (LAYEPS)  

have been implemented with User Language programs. 
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4.2 Display, Design Rule Check 

Element Fixed Mode Query 

The Query Element function from the View menu has been changed to indicate element fixed modes. 

Element Drill Class Query 

The Query Element function from the View menu has been changed to display non-default drill class settings 
for pins and vias. 

Fine Grid 

The 1/240 Inch and 1/480 Inch grid options have been added to the menus for setting the input and display 
grid. 

Polygon Display Patterns 

The Change Colors function from the View menu has been changed to allow for layer-specific polygon 
display pattern assignments. The color selection facility provides a graphical selection bar with outline, filled 
area and dotted outline default display modes and 32 different polygon display patterns. Arrows are used 
between the color and pattern selection bars to indicate color and pattern selections. 

The polygon display patterns are designed with offsets to ensure visual distinction of overlapping patterns 
and/or areas from different layers. Outline and pattern display modes with appropriate color assignments can 
be used to enhance the visibility of multi-layer structures and copper fill areas significantly. 

Polygon display patterns are only applied on-screen. I.e., CAM output is not affected by these settings. 

Advanced DRC Parameter Settings (BAE HighEnd) 

The Advanced DRC function from the BAE HighEnd Settings menu now provides a dialog for layer-specific 
minimum distance value settings. 

Netgroup-specific DRC (BAE HighEnd) 

The BAE HighEnd version supports netgroup-specific clearance parameters. This allows for the definition of 
clearance parameters to be used when checking elements of specific netgroups such as high and low 
voltage circuit blocks against each other. Netgroups can be definied in the Schematic Editor by assigning 
$nettype attribute values to nets. Nets without $nettype attribute value assignment are considered to be of 
type std. DRC block assignments through specific rule definitions are required for net type combinations 
which are to be checked. The nettype.rul rule definition file from the baeulc directory contains an example 
which shows how to use an alternate DRC block for checking hv (high voltage) net type elements against 
other net types. 
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4.3 Parts, Placement 

Part Name Selection 

The part name selection menu of the Add Part has been replaced by a comfortable dialog with a part name 
input field and scrollable listboxes for placed and unplaced parts, constructive parts and selected and 
unselected net list parts from the current part set. The name of the next unplaced part is loaded to the part 
name input field upon activation of the part name selection dialog. The Select Pattern, Deselect Pattern, 
Select All and Deselect All buttons can be used for direct part set manipulations. 

Via Selection 

A dialog with three scrollable listboxes for selecting currently defined vias, project file padstacks and library 
file padstacks has been implemented for the via selection function. 

Insertion Pick Point Coordinate Query 

The coordinates and rotation angles of part name texts on PHYSICAL documentary layers have been 
included to the report of the Place Data Query functions, thus allowing for part insertion pick point coordinate 
queries. 

4.4 Traces, Routing 

Move Segment 

The Adjust neighbours option has been added to the context menu of the Move Segment function from the 
Traces menu. Adjust neighbours considers intersection points between new and neighbouring segments and 
rearranges neighbouring segments accordingly. This feature is especially useful for moving diagonal 
segments at trace corners. The Move w.out neighb. option is applied if neighbouring segments cannot be 
rearranged. 

4.5 Graphic, Copper Areas 

Angle Measuring 

The Angle Measure option for generating angle measuring graphics has been added to the Drawing Utilities 
function from the Other Functions submenu of the Areas menu. Angle Measure prompts for a documentary 
layer and angle start, center and end points. The angle measuring circle segment graphic is then drawn 
clockwise from angle start to end point, and a measuring label text (angle value in degrees) is dropped for 
placement. 

Active Copper Areas on Part and Padstack Level 

The Add Active Copper for placing active copper areas with "no net" attribute assignment is now available on 
part and padstack level. On padstack level, active copper area placement is restricted to power layers. 
These new features allow for the definition of power layer milling cutouts on part level. 

Net Name Selection 

The net name selection menus of the polygon functions have been replaced by dialogs with scrollable net 
name selection list boxes. The system remembers the last selected net name and uses this name as default 
in subsequent net name queries. 
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4.6 Text, Drill 

Special Texts for Element Data Display 

The $pltfname (element file path name), $pltfsname (element file name) and $pltpname (element plan name) 
texts can be placed to display the project file path name, the project file name (without directory path) and 
the element name of the currently loaded element. 

Direct Power Layer Connection Display 

Drill holes with direct power layer connections are indicated through an X-shaped marker (matching the drill 
hole size) to distinguish such drill holes from drill holes without power layer connection. 

4.7 Group Functions 

Clipboard 

The Cut, Copy and Paste functions for saving and/or loading group elements to and/or from the clipboard 
have been added to the Edit menu. The data is saved in the BAE programs directory to a temporary file 
named hostnameclipb.dat (hostname is the network name of the host computer). 

Multiple Group Definitions 

The Set Group Name function for assigning a group name to the currently selected group elements has been 
added to the Other Functions submenu of the Edit menu. The Group Name has been added to the Select 
and Deselect group functions to allow for group selections through group name specifications. 

Unlike group selection status flags, group name assignments are saved with the project. I.e., group name 
assignments are permanent, allowing for grouped layout element to be easily re-selected and/or re-
processed in later sessions. 

Group Selection by Part Name 

The Name option for selecting and/or deselecting layout groups by part name has been added to the Select 
and Deselect functions from the Other Functions submenu of the Edit menu. The part name group selector 
can specified by picking from the list of currently used parts, or by part name pattern input. 

Group Selection by Polygon Type 

The Polygon Type option for selecting and/or deselecting polygon group elements by polygon type has been 
added to the Select and Deselect functions from the Other Functions submenu of the Edit menu. 

Group Selection by Net 

The Net option for selecting and/or deselecting layout group elements by net has been added to the Select 
and Deselect functions from the Other Functions submenu of the Edit menu. The net group selector is picked 
from the list of currently defined nets. All elements connected to the selected net are selected and/or 
deselected. Parts with at least one pin connected to the net fulfill the selection criteria. 

Change Polygon Type 

The Change Pol&y Types function for changing the polygon type of group-selected polygon elements has 
been added to the Other Functions submenu of the Edit menu. Polygon layer and net assignments are not 
affected by this function, and polygons with layer assignments incompatible to the new polygon type are not 
changed. 
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4.8 Automatic Copper Fill 

Copper Fill on Alternative Layers 

Automatic copper fill has been significantly improved to allow for the generation of different fill area types 
even on layers different from the current fill area layer. The Add Cop.-Fill Area function creates standard fill 
areas with identical source and destination layers. The Alternate Layer option of the Set Polygon Type/Net 
function from the Other Functions submenu of the Areas menu allows for the assignment of non-default fill 
area parameters. Alternate Layer requires net name, source layer, destination layer and area type 
specifications for the area to be generated. For signal source layers, the clearance calculation mode must 
also be selected. The Standard clearance calculation mode considers general and net-specific DRC 
parameters. The No DRC Clearances calculation mode ignores the DRC parameters and considers only the 
minimum distance specified for copper fill (which can be zero). 

These features allow for a series of new copper fill applications. Specific parameter settings and destination 
layer and area type specifications can be used to generate milling contours for prototype manufacturing, 
positive solder resist mask generation from negative layers, dielectric layer generation for hybrid circuits, etc. 

Fixed Active Copper Area Processing 

The Clear single area and Clear all areas functions from the Copper Fill submenu have been changed to 
retain fixed copper areas matching the copper fill area signal level. Such copper areas can be placed onto 
pins to create pin-specific power plane connections which can be different from the connections generated 
by automatic copper fill (e.g., direct connections instead of heat-traps). The Fix Group function from the Edit 
menu can be used to fix group-selected polygons (use, e.g., Group Elements for area group selection). 

Automatic Isolated Area Selection 

The Select Islands option has been added to the Settings dialog of the Copper Fill submenu from the Areas. 
With the Select Islands option, the automatic copper fill functions select isolated areas as they are created. 
Group-selected isolated areas can easily be recognized through group-highlight, and the user can 
subsequently decide whether to keep or delete these areas. 

Copper Fill Keepout Areas 

The Standard and Only Copper Fill modes have been added to the Keep Out Area polygon type selection 
option provided with the Set Polygon Type/Net function from the Other Functions submenu of the Areas 
menu. Standard creates default keepout areas to be used for DRC, copper fill, Autoplacement and 
Autorouter, whilst Only Copper Fill creates keepout areas only relevant for automatic copper fill. Copper fill 
keepout areas can be used to, e.g., suppress heat-trap connections for specific pin without causing DRC 
errors. 

Hatching Angle 

The Line Angle option has been added to the Settings dialog from the Copper Fill submenu of the Areas 
menu. Line Angle can be used to set the hatching angle for traces to be generated by the Hatch single area 
and Hatch all areas functions. A zero degree hatching angle setting might be useful to avoid problems when 
performing visual PCB checking automatically. 
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5 Autorouter 

5.1 Autorouter Algorithms 

Distance Check 

Distance checks on fixed traces were carried out using wrong trace width values (trace diameter instead of 
trace radius). This could cause redundant/erroneous Trace out of border! messages for thick trace 
segements placed close to the board outline. This bug has been fixed. 

Short-Circuit Problems 

The Autorouter sometimes created short-circuits to nets with pins blocked by keepout or copper areas. This 
problem has been fixed. 
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6 CAM Processor 

6.1 General 

User Language Programs 

A series of new CAM Processor functions and features such as 

• Arbitrary scaling factor settings for EPS and PDF output (LAYEPS)  

have been implemented with User Language programs. 

6.2 Gerber Output 

Extended Gerber Output 

Pads with Area Mirror Display assignments for mirrored output were not processed when generating 
dynamic aperture tables for Extended Gerber output. This problem has been fixed. 

6.3 Drilling Data Output 

Sieb & Meyer Formats 1000/3000 

The Sieb & Meyer 1000 and Sieb & Meyer 3000 output format options have been added to the Drill Data 
Output function from the Import/Export submenu of the File menu. These formats include the drill tool table 
with the drilling data output file, thus eliminating the need for transmitting the drill tool table in a separate file. 
The Sieb & Meyer 1000 drilling coordinates resolution/accuracy is 1/100 mm, whilst the Sieb & Meyer 3000 
drilling coordinates resolution/accuracy is 1/1000 mm. 
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7 CAM View 

7.1 General 

Interactive Zoom Window Selection 

CAM View now supports interactive zoom window selection whilst the left mouse button is pressed. 



Bartels AutoEngineer  Version 5.4 

Release Notes  Page 30 

8 Neural Rule System 

8.1 General 

Rule Definitions 

The brules.dat file installed to the BAE programs directory contains precompiled rule definitions. The source 
files for these rule definitions are also provided (User Language directory; file extension .rul), i.e., the rule 
definitions can be modified and recompiled with the rulecomp Rule System Compiler. 

Project-specific Rule Database 

Rules referenced throughout a project are now automatically copied from the global rule database file 
(brules.dat) to the project file. This allows for the transfer of project files with specific rule definitions to a 
different user and/or BAE installation without having to transfer and compile the referenced rule definitions in 
a separate step. 

The COPYDDB utility program has been adapted accordingly - referenced rule definitions are automatically 
copied with each element. 

8.2 SCM Rules 
BAE Version 5.4 provides a series of new rules for the implementation of special SCM features (e.g., text 
class assignments). See chapter 2 of this documentation for a description of these rules and their 
applications. 

8.3 Layout Rules 
BAE Version 5.4 provides a series of new rules for the implementation of special layout features (e.g., group 
name assignments to elements). See chapter 4 of this documentation for a description of these rules and 
their applications. 
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9 Utilities 

9.1 COPYDDB 
The -rule option for copying rule definitions has been added to the COPYDDB utility program. 

9.2 LOGLIB 

Logic Synthesis 

The LOGLIB utility program supports the new architecture command for the definition of logical parts 
consisting of different arbitrarily connected SCM symbols and/or layout parts. This allows for the definition of 
schematic symbols consisting of different layout parts (e.g., 16-bit driver logic consisting of two physical 8-bit 
drivers) without having to apply hierarchical design. 
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10 Bartels User Language 

10.1 General 
This section describes general changes to the User Language specification. See Bartels User Language 
Programmer's Guide - Chapter 2 for a detailed description of the User Language specification. 

Internal User Language Version 

The internal version of BAE Version 5.4 User Language has been changed. All User Language programs 
compiled under earlier BAE versions won't execute in the BAE Version 5.4 User Language interpreter 
environment (error message User Language program version incompatible!). This means that each User 
Language program compiled under earlier BAE Versions must be recompiled under BAE Version 5.4 in order 
to regain compatibility. 

10.2 User Language Compiler 
This section describes the news and changes introduced to the BAE User Language Compiler. See Bartels 
User Language Programmer's Guide - Chapter 3 for detailed information on how to operate the User 
Language Compiler. 

Optimizer 

The Optimizer of the User Language Compiler has been updated to allow for the substitution of the loadv 
(Load variable) and loads (Load stack) machine instructions with the new and more efficient loadvd (Load 
variable destructive) and loadsd (Load stack destructive) machine instructions, respectively. The substitution 
takes place in assignment operations where the assigned variable on the left is part of the assignment 
expression on the right (n = 5 * n, s += s + "ABC", increment, decrement, etc.). 

10.3 User Language Interpreter 
This section describes the news and changes introduced to the User Language Interpreter. See Bartels 
User Language Programmer's Guide - Chapter 3 for detailed information on how to operate the User 
Language Interpreter. 

Machine Instruction Set 

The loadvd (Load variable destructive) and loadsd (Load stack destructive) instructions have been added to 
the machine instruction set, and the Optimizer of the User Language-Compiler has been redesigned to 
substitute loadv (Load variable) and loads (Load stack) instructions with the more efficient loadvd and loadsd 
instructions if possible (see above). 

The addstr (Add string) machine instruction for concatenating strings has been optimized This optimization 
reduces the computing time used for concatenating long strings by roughly 50 percent. The performance of 
User Language programs which create long strings can be significantly increased (factor 10 to 20) by 
assembling long strings from short string concatenations instead of repeatedely concatenating short strings 
to long strings. 
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10.4 Index Variable Types 
This section lists the new and changed User Language index variable type. See Bartels User Language 
Programmer's Guide - Appendix B for a detailed description of all index variable types. 

New Index Variable Types 

The following new User Language index variable types have been implemented for BAE V5.4: 

IP Index Variable Type Short Description 

CL_ALTPLNAME Layout Net List Alternate Part Package 

CL_ATTRIBUTE Layout Net List Attribute 

CL_CNET Layout Net List 

CL_CPART Layout Net List Part Entry 

CAP 

CL_CPIN Layout Net List Part Pin Entry 

Changed Index Variable Types 

The int attribute VIS for net visibility queries has been added to the L_CNET index variable type. 

The int attribute RULEOBJID for element-sepcific rule object queries has been added to the I_FIGURE index 
variable type. 
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10.5 System Functions 
This section lists the new and changed User Language system functions. See Bartels User Language 
Programmer's Guide - Appendix C for a detailed description of all system functions. 

New System Functions 

The following new User Language system functions have been implemented for BAE V5.4: 

IP System Function Short Description 

bae_asksymname Interactive BAE library element query 

bae_dialadvcontrol Add advanced BAE dialog element 

bae_getpackdata Get BAE Packager data 

bae_menuitemhelp Display BAE menu item help 

bae_setplanfname Set BAE project file name 

launch Pass command to operating system without waiting for completion 

STD 

rulecompile Compile a rule definition 

cap_findlayconpart Get layout connection list part index 

cap_findlaycontree Get layout connection list net name net index 

cap_getlaytreeidx Get layout connection list net number net index 

CAP 

cap_layconload Load layout net list 

scm_attachtextpos Attach text position to SCM element 

scm_checkjunctplot Get SCM junction point plot status 

scm_chkattrname SCM attribute name validation 

SCM 

scm_gethpglparam SCM HPGL parameter query 

ged_askrefname Interactive GED reference name query 

ged_asktreeidx Interactive GED net query 

GED 

ged_attachtextpos Attach text position to layout element 

cam_getdrlaccuracy Get CAM drill tool tolerance CAM 

cam_setdrlaccuracy Set CAM drill tool tolerance 

Changed System Functions 

The system function has been changed to wait for command completion in any operating system 
environment before returning to BAE. 

A new parameter for specifying part processing mode flags (remove from screen, screen redraw) has been 
added to the scm_setpartattrib function. 

The ged_groupselect provides new modes for selecting elements with or without connection to specified 
tree/net numbers and for selecting elements by polygon type. 
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10.6 BAE User Language Programs 
BAE installs some 200 pre-compiled User Language programs to the bsetup.dat file of the BAE programs 
directory. Additionally, the User Language source files (more than 3.5 Mbytes; more than 120,000 lines) are 
installed to a special directory (baeulc). See Bartels User Language Programmer's Guide - Chapter 4 for 
a complete listing and short descriptions of the BAE User Language programs. 

Include Files 

The User Language include files already delivered with the previous BAE Version have been completely 
revised and extended by a series of new definitions and functions. 

The following new User Language include files are provided with BAE Version 5.4: 

IP Include File Short Description 

ICD ICD.ULH IC Design Utilities 

The baewsresize and baewsshrink functions for Schematic Editor, Layout Editor and Chip Editor workarea 
manipulation have been integrated to the STD.ULH include file. These functions replace the corresponding 
functions from SCM.ULH (scmwsresize and scmwsshrink) and GED.ULH (gedwsresize and gedwsshrink). 
All User Language programs have been changed to use the new workarea functions as required. GED.ULH 
has become redundant and was removed from the BAE software. 

New User Language Programs 

The following new User Language programs are provided with BAE Version 5.4: 

IP Program Name Short Description 

SCM ATTRSET SCM Symbol Attribut Assignment 

GED ICAPNET ICAP Logical Netlist Import 

ICD ICDPCR IC Design Report 

CED_MS Chip Editor Mouse Action 

CEDDISP Chip Editor Display Functions 

CEDGROUP Chip Editor Group Functions 

CEDMACL IC Design Macro Load 

CEDPART Chip Editor Macro and Placement Functions 

CED 

CEDPOLY Chip Editor Polygon Functions 

Changed User Language Programs 

The User Language programs already delivered with the previous BAE Version have been completely 
revised and extended by many new features and functions. A series of significant improvements and 
enhancements have already been mentioned in the previous sections of these Release Notes. 
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